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Introducing CorelCAD™ 2015

CorelCAD" 2015 is the smart solution for day-
to-day design work requiring precision and
detail, providing high-level CAD performance
without the high cost typical of CAD solutions.

Enterprises that rely on CAD have always had
tough choices to make about software. While
there are several budget-priced alternatives,
many lack critical tools or use a format that
impedes collaboration and sharing. CorelCAD
2015 simplifies things by offering an
inexpensive, full-featured 2D CAD application
with 3D solid modeling tools.

The use of CAD files is becoming more
commonplace for a wide range of graphics
professionals, from technical illustrators to
designers in marketing departments — even
among 3D printing enthusiasts. As such, the
ability to open and repurpose CAD content,
such as .DWG files, has become a requirement
that saves organizations both time and money.

The native CorelCAD file format (.DWG)
supports the latest AutoCAD .DWG file format
(R2013 .DWG, as used by AutoCAD 2013 -
2015), ensuring total fidelity with the industry
standard. CorelCAD can also handle the file
attributes of non-supported AutoCAD features
and preserves functionality in .DWG files,
eliminating conversion and sharing issues.

If you're familiar with other popular CAD tools,
making the transition to CorelCAD 2015 is
straightforward. CorelCAD incorporates a
range of tools, commands, and Ul elements
found in other CAD software so any CAD
designer can quickly get to work with no
learning curve.

Windows has traditionally been the operating
system of the CAD world, but there are pockets
of dedicated Mac users. With that in mind,
CorelCAD is optimized for both platforms —
and at a fraction of the price of other CAD
software available for the Mac.
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Customer profiles

Architects, Engineers, and CorelCAD 2015 offers a lightweight, standards-

: : : compliant 2D application that supports 3D
Construction (AEC) service prowders solid modeling. The ability to work in the .DWG

format, including AutoCAD

2015 .DWG files,

In the AEC sector, CAD designers work primarily eliminates any conversion issues when

in 2D, but with an increasing emphasis on 3D exchanging files with colleagues or reusing
design. They work for small to medium-sized legacy files. Collaboration is simplified and
firms and create a variety of drawings, accelerated through support for voice

including 2D designs for drafting and notations and commenting

in editable

construction plans, elevations, floor plans, and drawings. Plus, files can be exported to
construction details. Their projects are just as CorelDRAW (CbR)* Corel DESIGNER (DES)*
likely to be created from scratch as to be based and PDF, simplifying information sharing with
on legacy design components. The ability to other departments in their company, such as
collaborate and exchange files with colleagues documentation or marketing. What's more
and clients is critical to their workflow. And, CorelCAD 2015 is optimized for both Windows
many architects prefer the Macintosh operating and Mac OS, so users can work on the platform
system or work in a hybrid Windows PC and they prefer.

Macintosh environment.

* Windows version only
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3D Enthusiasts and DIY designers
for 3D printing

3D enthusiasts and Do-It-Yourself (DIY)
designers for 3D printing are playing a critical
role as this technological revolution becomes
more mainstream. They're at the forefront of
realizing the unlimited potential and output
possibilities of 3D printing.

The foundation of their 3D printing projects is
built using 2D vector graphics. The first step in
their workflow is a 2D sketch because it's
easier, faster and more intuitive than
attempting to draw a 3D design from scratch.

After exporting the 2D design to .DWG, they
use a 3D design application to complete the

oo EGRRCEEE
Home Solids and Meshes Insert  Annotate  Sheet Manage  View

CorelCAD™ - [.\3D printing gear x15.dwg]

transformation from 2D to 3D. They then
export it to print on a 3D printer or send it to a
3D printing output service.

CorelCAD is part of a powerful range of Corel
products that provide all the specific tools
needed for a 3D printing project. The ability to
directly import CoreIDRAW (CDR)* sketches
means users can move from the initial
sketching to the 3D design phase without any
disruption. Then, DIY designers turn to
CorelCAD 2015 for a simplified 2D-to-3D
conversion process and precise design tools to
complete the project. They also seek the file
compatibility CorelCAD 2015 offers with a
range of common formats integral to 3D
printing projects.

* Windows version only
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Occasional 2D CAD users

There are two groups of occasional 2D CAD
users, each with distinct needs and workflows.

Firstly, CAD designers working for large
enterprises in the manufacturing sector design
primarily in 3D, however, they still need 2D
support. The types of drawings they design
include assembly schematics and parts details,
and many of their legacy files are 2D CAD
(.DWG@G), which have to be maintained. A 2D
draft will often serve as the basis for a 3D
design, and they need to be able to repurpose
3D files to add detail to 2D drawings. To share
their work with other departments, they
publish CAD drawings to a range of formats.

Drafting and Annotation | v | & Ly | &=

) @ Bl

Secondly, graphic designers need a tool to edit
CAD files that supports all elements of .DWG
drawings, such as model spaces and layout
sheets. They work in marketing and technical
documentation departments, and the ability to
work with 2D CAD files allows them to reuse
design content in user guides, marketing
materials, and presentations.

CorelCAD addresses these needs by offering an
affordable, standards-compliant 2D CAD
application that complements 3D CAD
solutions. The ability to import drafts from
CorelDRAW (CDR), and export CAD drawings
to CorelDRAW and Corel DESIGNER file
formats* simplifies repurposing content,
ensuring that users can maintain and reuse
legacy content.

* Windows version only
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Key features

With native .DWG file support, industry-
standard CAD features, customizable 2D and
3D design tools, and compatibility with a range
of common formats, CorelCAD 2015 helps
users be more productive. Optimized for both
Windows and Mac OS, CorelCAD delivers
impressive speed, performance, and
customization on your preferred platform.

Precise 2D drafting and 3D design
solutions

Along with its comprehensive set of 2D
drafting and drawing features, CorelCAD 2015
includes a set of 3D solid modeling tools at just
a fraction of the price you'd expect.

New! Editing tools: CorelCAD 2015 helps you
increase productivity with an expanded toolset
that's designed to streamline 2D editing. The
ExplodeBlockX command lets you explode
blocks while maintaining their attribute values,
and the DiscardDuplicates command simplifies
geometry by removing overlapping segments.
You can also precisely and interactively trim
onscreen areas with the PowerTrim tool. The
QuickModify tool is a great time-saver, allowing
you to simultaneously move, rotate and copy
design elements.

]

Give it a try

Trimming adjacent entities

1 Click File menu » New, choose the standard
template, and click Open.

2 Click the Rectangle tool 3 in the toolbox,
and draw a rectangle.
3 With the rectangle selected, click the
ooo .
Pattern tool 881 in the toolbox.

4 |In the Pattern dialog box, enable the Linear
option, and click OK.

5 Click Modify menu » Power Trim.

6 In the graphics area, click and drag the
pointer over each entity you want to trim.

A trail is created along the trim path.

7 To finish trimming, release the mouse
button, and press Enter.

Enhanced! Tables: Tables are often used to
communicate important information in a CAD
drawing, from bills of materials to project
schedules. Updating or tweaking tables can be
time-consuming and tedious work, but
CorelCAD 2015 simplifies the process. You can
now add and remove table rows, columns, and
cells within CorelCAD 2015. You can even
embed a Microsoft Excel spreadsheet as a
linked object* so that the most up-to-date
information is always in your design (*Windows
version only). In addition, you can edit the

CorelCAD 15
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embedded spreadsheet in the CAD drawing
using OLE in-place editing tools.
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Give it a try

Embedding spreadsheets (requires Microsoft Excel)

1 In the 3D Modeling or Drawing and
Annotation workspace, click the Insert tab.

2 In the Data group, click Object.

3 In the Insert Object dialog box, enable the
Create from File option.

4 Click Browse, and navigate to the sample
file BoM.xls (available for download here),
click Open, and click OK.

The spreadsheet is inserted as an editable
table.

5 Click in a table cell, and modify its contents.

New! Dimension palette: This new pop-up
palette lets you work more efficiently with
dimensions. It only appears when you need it,
displaying all dimension-text formatting and
property settings for quick editing. The
Dimension palette also speeds up your
workflow by simplifying the reuse of text,
precision, and tolerance settings and allowing
you to modify multiple dimensions at the same
time.

JGMKII-1
0.9 mm

nogrniting small

Give it a try

Using the Dimension palette

1 Click File menu » New, choose the standard
template, and click Open.

2 Click the drop-down menu cassic pefautt [+] IN
the upper left corner of the workspace,
and choose Drafting and Annotation.

3 Click the Home tab.

4 |In the Draw area, click the Rectangle
group, choose Rectangle, draw two
rectangles, and select one of them.

5 Click the Annotation tab.

6 Click the Dimensions group, and choose
Linear, and add a dimension.

7 Move the pointer over the dimension to
display the Dimension palette.

8 Enter text in the Above Text field.

9 Click the Unit Precision drop-down menu,
and choose 0.0.

The changes appear in the drawing as you
modify the settings.

10Click the Add or Update Favorite button,
click the Sphere group, and choose Sphere.

11 In the Add or Update Favorite dialog box,
type a name for this group of settings in
the Specify a name or select an existing
one field.

12 Select the second rectangle, and add a
dimension.

13 Move the pointer over the dimension to
display the Dimension palette.

14Click the Favorites List button, and choose
the settings you saved from the first
rectangle.

Note the dynamic preview of the stored
favorites that displays how the selected
dimension will look based on the favorite
settings.

[ 8 ] Reviewer's Guide
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http://www.coreldraw.com/static/product_content/corelcad/2015/corelcad2015-sample-files.zip

Give it a try

15Select the first rectangle, and add a
dimension, and move the pointer over the
dimension to display the Dimension
palette.

16 Click the Apply Default button to revert
the dimension to its default settings.

New! Drawing constraints: The new drawing
constraints feature help you work more
efficiently and precisely. The dimensional
constraints let you force object dimensions to
adhere to fixed sizes and angles. The geometric
constraints let you control dependencies and
relationships between shapes in your 2D
designs. For example, when you're working
with designs that contain a variety of window
types, you can vary the size of windows while
maintaining the distance between the frame
and the glass. Drawing rules can be defined on
an object level so that variants can be quickly
created without having to stick to the
constraint.
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Smart drafting tools: CorelCAD 2015 has all
the smart drafting tools you expect in CAD
software, offering the same functionality that
professional designers have grown accustomed
to in graphics software. You can speed up
drafting with a variety of entity snap modes,
entity tracking, and polar guides. Custom
coordinate systems can be created to align the
construction plane with drawing objects. You

can also save time by using EntityGrips to
quickly reposition, align, copy, or resize
entities.
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Solid modeling tools: With its 3D solid
modeling tools, CorelCAD 2015 ensures that
you can work with increasingly common 3D
designs. Just like 3D CAD applications, you can
add 3D solid primitives to your design and use
Boolean operations to unite, intersect and
subtract bodies. 2D entities can be extruded,
revolved, or swept along a path. You can also
loft between 2D entities to create solid objects.
CorelCAD 2015 also gives you the ability to
slice and intersect solids, and edit edges, faces
and bodies of 3D solids.

CorelCAD 15
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Give it a try

Designing in 3D

1 Click File menu » New, choose the standard
template, and click Open.

2 Click the drop-down menu cassic pefautt [+] IN
the upper left corner of the workspace,
and choose 3D Modeling.

3 Click the Solids and Meshes tab.
4 Click the Sphere group, and choose Sphere.

5 Click in the graphics area to set the center
point, and drag to set the radius.

6 Click the View tab, and click View Tiles
Manager.

7 In the View Tiles dialog box, click New, and
then choose 3D from the Orientation drop-
down menu.

8 Choose Four:Left from the Default
configurations list, and click OK.

9 Click the Rectangle tool £33 in the toolbox,
and draw a rectangle.

10 Click the Solids and Meshes tab, and click
Extrude in the Draw area.

11 With the box and sphere selected, click
Shade.

Print 3D designs from CorelCAD: You can
export multiple 3D solid objects to
stereolithographic file format (STL), the most
commonly used format for processing 3D
prints. STL support provides a direct connection
to most 3D printers, which lets you print 3D
prototypes, spare parts, custom 3D creations —
the possibilities are endless.

Align Viewport tool: The Viewport command
makes it easier than ever to arrange the
elements of your drawings and gain better,
more accurate sheet alignment. With CorelCAD
2015, viewports are aligned by the geometry
within each viewport. This means that users no
longer have to rely on guesswork to determine
if their locations are precise.

Layer Preview: With CorelCAD 2015, you can
quickly and easily preview the content of layers
in complex CAD files. This helps you to
understand a drawing's layer structure and find
specific content.

Give it a try

Previewing layers

1 In the 3D Modeling or Drawing and
Annotation workspace, click the Home tab.

2 In the Layer group, click the Layer Preview

ﬁ button.

A list of all layers appears in the Layer
Preview dialog box.

3 Click a layer to view its contents.

You can also Ctrl-click several layers at once
to view their contents.

Organized layouts: CorelCAD lets you organize
drawings into multiple tiled layouts using
tabbed sheets. Each sheet can determine a
different style of printing or plotting. The
drawing window can be divided into multiple
views, each displaying the drawing from a
unique perspective. You can place drawing
borders, title blocks, equipment lists, or other
information on the sheets. You can also switch
between model and paper space with just a
double-click to adjust the representation of the
model or edit it.

ExplodeX command: You can use this
command to convert ellipses and splines into
polylines, which is particularly beneficial for
preparing drawings for export to other
software applications or devices that do not
support ellipses or splines (for example, legacy
engraving devices). In addition, you can use the
Explode command for other complex entities,
such as Blocks.

Unique collaboration tools: Most CAD projects
demand the input and feedback of an entire
team, so effective collaboration and annotation
tools are critical. With the VoiceNotes feature,

[ 10 ] Reviewer's Guide
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CorelCAD 2015 lets you add recorded messages,
reminders, or instructions directly in your
drawing. Great for a quick onsite or in-meeting
review, VoiceNotes allow you to quickly
document your ideas so they can be
incorporated later.

You can also easily mark up drawing items with
freehand sketches or attach other drawings and
images as references, which can be clipped to
show only the relevant portions. To accelerate
and simplify reviews, you can mask portions of a
drawing to exempt them from annotations.

Texk: Audio: 0 secs

Correck

" 0K | | X Cancel | Help |

Give it a try

Annotating with VoiceNotes

1 In the 3D Modeling or Drawing and
Annotation workspace, click the Annotate
tab.

2 In the Markup group, click Insert/Edit
VoiceNote.

3 Select a point in the drawing to place the
VoiceNote and open the VoiceNote dialog
box.

4 Using the controls in the VoiceNote dialog
box, record an audio note. You can also
add a text message to a VoiceNote.

5 Click OK.
A VoiceNote icon appears in the drawing .

You can open a VoiceNote by typing
VoiceNote at the command prompt, and
clicking a VoiceNote icon.

QuickGroup: This command makes it easy to
quickly group drawing entities. You simply
select the entities you want to group, right-
click and choose Entity Group » Quick Group.

Revision Cloud tool: With CorelCAD 2015, you
can create Revision Clouds to highlight areas
that require or contain revisions, making the
review and revision processes simpler and more
efficient. Drawing areas can be accentuated
with specific shapes, such as rectangular,
elliptical, and freehand clouds. In addition, you
can set the specific layer for a cloud, line color,
style, and weight, as well as adjust the radius
of the cloud'’s sequential arc.

CorelCAD 2015
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Advanced .DWG file support and
industry-standard tools

While most CAD tools let you work with
AutoCAD .DWG files, many employ their own
native file formats. Often, converting these file
formats to and from .DWG, causes critical loss
or misrepresentation of parts of the drawing.
And some CAD tools are unable to open these
third-party proprietary file formats. CorelCAD
2015 uses .DWG as its primary drawing format,
so you're assured of worry-free collaboration.

Many CAD tools and their proprietary file
formats contain elements that aren’t supported
in .DWG. And conversely, AutoCAD has features
that aren’t supported by some applications,
which can cause untimely and unwanted
surprises during file conversion. With CorelCAD
2015 and its ability to process the file attributes
of non-supported AutoCAD features, you'll
enjoy full compatibility when collaborating with
partners and customers who work with the
DWG file format.

CorelCAD 2015 is compatible with any file saved
as in AutoCAD R12 through AutoCAD R2013
.DWG. The ability to save drawings to widely
adopted R12 .DWG and .DXF formats means
that you can continue to work with any legacy
hardware, such as a laser engraver or plotter
that only reads that version. Plus, you can even
use CorelCAD to recover damaged or corrupted
.DWG and .DXF files in all format versions.

o oxating snd Anatation. 0] (3 65 [ 8 ) ( [d) #

11111 et Ammotate  Wheet  Contisnts  Mansge  View

ComCAD™ « | \Faametric. dwg”]

14 ASCH Drawing (" el

R1H ASCE Drpwing {* )

K12 MH e
)

What's more, CorelCAD 2015 offers industry-
standard tools and compatibility with all major
CAD programs, facilitating collaboration and
file sharing.

Enhanced! Ribbon user interface (Ul): Familiar
Ul and efficient tool access help to ease the
transition for new users migrating from other
Windows-based CAD applications, such as
AutoCAD. CorelCAD 2015 is compatible with
all major CAD programs so users will feel at
home working with a classic Ul and traditional
menu items or modern ribbon Ul workspaces.
In addition to offering workflow-oriented
Ribbon workspaces*, such as 2D Drafting or 3D
Modeling, CorelCAD 2015 lets you tailor a
workspace to specific needs with Ribbon Ul
customization. Plus, you can easily import
customized AutoCAD workspace files (CUIX)
and map those tools and functions directly to
the CorelCAD ribbon.

[ 12 ] Reviewer’'s Guide

CorelCADzo1s

powered by ARES®



Give it a try

Choosing and creating a Ribbon workspace

1 Click the drop-down menu  ciassic pefautt [] N
the upper left corner of the workspace, and
choose an option:

* 3D Modeling
* Drafting and Annotation

2 Click the Manage tab, and click Interface in
the Customization group.

3 On the Interface page of the Customize
dialog box, expand Ribbon, then Tabs.

4 |In the Tabs tree view, right-click and click
New Tab.

5 Click Show ribbon explorer to expand the
Ribbon Explorer.

6 In the Appearance area, edit the tab name
in the Display text field.

7 Add panels to the tab.

Familiar CAD user interface: If you've worked
in other popular CAD applications, there’s no
learning curve with CorelCAD, so you can be
productive immediately. Offering a familiar
CAD user interface — including the command
line— you can quickly get to work by using the
same commands and keyboard shortcuts you
already know.

ey | (] | | | [y | (] || (WS 0TS0 i

AutoCAD 2013/2015 .DWG support:

CorelCAD 2015 saves to R2013 .DWG natively,
which ensures full compatibility, support,
features, and CorelCAD file attributes in .DWG
format. This level of support is paramount for
users who receive and manipulate files created
with AutoCAD 2015, AutoCAD 2014 or
AutoCAD 2013, and ensures that you can
seamlessly work with customers and partners
who use AutoCAD.

CAD standards verification: CorelCAD 2015
makes it easy to verify a drawing to ensure
compliance with industry, corporate, or project
standards. The VerifyStandards command checks
the current drawing to match naming
conventions, such as layer properties, line styles,
dimension styles, and text styles, with an
associated Drawing Standards file (DWS). You
can then quickly replace any nonstandard items.

Standard violation:
TextStyle: Standard

TextStyle properties are non-standard,

Replace with:

TextStyle Standards File
AEC-BM-2015.d...

Preview of changes

Property Current Walue Standard Walue

Alt precision 2 3

Alt scale 254 00394
Alttol precision 2 3
Arrow size 018 25
Center mark size 0.09 25
Precision 4 2

[] 1gnare this standards violation

| Optians. .. | | Fix | | Mext |

Give it a try

Verifying a drawing

1 To associate a Drawing Standards (DWS)
file, in the 3D Modeling or Drafting and
Annotation workspace, click the Manage
tab.

2 In the Standards group, click Drawing
Standards.

3 In the Options - Drawing Standards dialog
box, click the New €@ button.
4 In the Select File dialog box, navigate to the

folder containing your drawing standards
files, select one, and then click Open.

5 In the Standards group, click Verify
Standards.

CorelCAD 15
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Give it a try

6 In the Verify Standards dialog box, select
any item that violates drawing standards.

7 In the Replace with area, select a drawing
standard that matches the intended
appearance, and then click Fix.

Design Resources docker: With the handy
Design Resources docker, you can quickly
access and repurpose existing design assets,
such as blocks, dimension styles, layers, line
styles, reference drawings, sheets, table styles,
and text styles. The Design Resources docker
makes it easy to find and access both local and
network design assets.

1
.;

Give it a try

Using the Design Resources docker

1 In the classic CorelCAD 2015 workspace,

click the Design Resources [if§ button on the
property bar.

In any CorelCAD 2015 workspace, you can
open or close the Design Resources docker
by pressing Ctrl+2.

You can also right-click the property bar
and choose Design Resources from the
drop-menu.

Give it a try

2 In the Folders section, navigate to a folder
containing .DWG files and select a file.

3 In the Contents section, choose one of the
following options to see the reusable
assets:

* Blocks

* Dimension Styles

e Layers

* Line Styles

* Reference Drawings
* Sheets

* Table Styles

 Text Styles

When you choose an asset from the
Contents area, the content is displayed in
the Preview area.

4 Click to insert the asset in the current
drawing.

Properties docker: Whether your background
is graphic design or CAD, the Properties docker
is a familiar, versatile feature. It gives you the
ability to manipulate the geometry and
properties of entities, including layers, colors,
line styles, and line weights. You can also use
the Properties docker to easily copy attributes
from one object to another.
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Enhanced! In-place text editing: Instead of
using a separate dialog box, CorelCAD offers
direct onscreen text editing. And in CorelCAD
2015, you can quickly stack text and paste
formatted text from Microsoft Word within
your project. With in-place text editing, it's
easy to modify the definitions of components
(block definitions) or elements (referenced
drawings). Plus, for greater efficiency,
Component instances in your drawings now
show changes in real time.

Search in Options dialog box: CorelCAD 2015
provides search capability in the Options dialog
box, making it faster and easier to locate
relevant settings, preferences, drafting styles,
drawing file properties, and more. This also
enables quicker customization by eliminating
the need to manually navigate various tabs in
the Options dialog box. In addition, users who
are new to CorelCAD will be able to instantly
find comparable features and functions by using
familiar search terms, which can save valuable
time while migrating from another application.

Give it a try

Searching the Options dialog box

1 In the 3D Modeling or Drafting and
Annotation workspace, click the Manage tab.

2 In the Customization group, click Options.

3 In the Options dialog box, type a keyword
in the Find field.

A drop-menu updates in real-time as you
type, offering immediate results.

For example, by typing (layer) you'll be
presented with options relevant to layers.

4 Choose an option from the drop-menu to
access the appropriate command or setting.

Layer Transparency: With support for
AutoCAD R2013 .DWG file formats,

CorelCAD 2015 ensures full visual integrity
with existing CAD files. For advanced designs,
you can apply layer transparency to highlight
specific content, or to make content below the
current layer visible.

PDF Underlay: You can reference PDF files in a
drawing as a PDF Underlay. You can specify the
layer visibility of PDF Underlays, clip the PDF
Underlay to display only a portion of the PDF,
and detach underlayers from current drawings.
CorelCAD 2015 also supports Microstation
DGN files as underlays.

Hassle-free file sharing: CorelCAD 2015
facilitates collaboration with colleagues and
clients by providing support for a variety of
leading industry-standard formats, including
SVG, ACIS SAT, and DWF. Plus, the ability to
save to PDF ensures that non-CAD users can
always view your drawings.

Work with GIS files: CorelCAD 2015 provides
support for GIS files in ESRI Shape (.SHP) file
format. This lets you visualize maps and
geospatial models that were created by
geographic information systems (GIS)
applications.

Repurpose 3D CAD files: With support for the
popular 3D exchange file format ACIS SAT,
CorelCAD 2015 ensures that you can open and
work with 3D models.
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Powerful CAD engine and
CorelDRAW graphics support

CorelCAD 2015 delivers state-of-the art CAD
expertise and performance with the renowned
ARES platform. With modern code and a
popular 64-bit application, you'll have the
speed you need for productivity.

CorelCAD for Windows offers support for
CorelDRAW® (CDR)* and Corel DESIGNER®
(DES)* file formats, ensuring a seamless
workflow, from sketching and technical design,
to presentation and technical documentation.

Native 64-bit support: For both Windows and
Mac OS workflows, CorelCAD 2015 provides
64-bit CAD environments that can seamlessly
process large CAD files. Plus, a 32-bit version is
included for Windows users who may need to
work with less powerful hardware
configurations.

Application performance and speed: With its
native 64-bit architecture, CorelCAD 2015
offers increased application speed for both
Windows and Mac OS users. The application
also provides accelerated display regeneration,
which results in smoother zooming and
panning operations in large and complex CAD
drawings.

Access drafts and sketches from CorelDRAWe®*:
Many designers prefer to use a creative
graphics application for making first sketches,
prior to getting down to the precise CAD
drafting and 2D/3D modeling work. With
CorelCAD 2015 for Windows, you can import
CorelDRAW (CDR) and Corel DESIGNER (DES)
files as model space objects with a
representation in a layout sheet. You can also
work seamlessly with multi-page CDR files
(from version 8 to X7) and DES files (from
version 10 to X6).

Publish to CoreDRAW® and Corel DESIGNER®*;
CAD files aren’t used only in Engineering
departments; however, integrating CAD files
into other corporate workflows has always

been a challenge. Graphics professionals
working in other areas of a company regularly
have to deal with CAD files because they often
contain content ideal for presentations,
technical documentation, or marketing
materials. CorelCAD 2015 for Windows
simplifies the repurposing of CAD files by
offering export to CoreIDRAW and Corel
DESIGNER formats*, so you can quickly access
and easily reuse that information.

* Import and export of CorelDRAW (.CDR) and Corel
DESIGNER (.DES) file formats is only available in CorelCAD
2015 for Windows.

[ 16 ] Reviewer’s Guide
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Flexible licensing and customization
options for Windows & Mac OS

You can work quickly and efficiently on both
Windows and Mac OS, and flexible licensing
options ensure that CorelCAD 2015 adapts to
your working needs.

And with CorelCAD 2015, you don’t need
programming knowledge to customize the
interface. It's also easy to reuse existing
macros, automate tasks, or add new
functionality.

Flexible licensing options: You can match your
working environment to your design needs
with the flexibility of CorelCAD. As a hybrid
product (Windows PC and Mac), this
application can be used in a variety of ways
and one license can be used on both your
desktop and laptop.

Operating system freedom: CAD programs
have traditionally been designed to run almost
exclusively on Windows operating systems, but
CorelCAD changes that. Whichever OS you
prefer, Mac or Windows, CorelCAD lets you
work quickly and efficiently on your platform of
choice. And while some Mac OS CAD tools
aren't nearly as feature-rich as their Windows
equivalent, CorelCAD is designed to give
Windows and Mac users almost the same level
of functionality (all features apply to both
operating systems unless noted). For a
comparison of features available on Windows
and Macintosh operating systems, see
“Comparing CorelCAD 2015 for Windows

and Mac OS to Light CAD applications” on
page 21.

Windows 8 and Mac OS support: CorelCAD
2015 is fully accessible for Windows 8 users
through the desktop. Mac users can take full
advantage of new Mac OS X features,
including full screen application mode. Plus,
CorelCAD 2015 is optimized for high DPI
resolutions, ensuring that Ul elements appear
crisp and legible when displayed on high
resolution monitors.

Automation support: You can extend your
productivity by taking advantage of the LISP
and Microsoft Visual Studio Tools for
Applications (VSTA)* programming interfaces
to automate repetitive tasks and create your
own functions, routines, and plug-ins. You can
also access the plug-in store for CorelCAD Add-
Ons and third-party enhancements that can
help you add new functionality to the
application (*windows version only).

Enhanced! Microsoft Visual Studio Tools for
Applications (VSTA) support: In CorelCAD
2015, VSTA support has been updated and
enhanced. For Windows users with a Microsoft
Visual Studio licence, CorelCAD 2015 offers
built-in VSTA features, which make it easy for
anyone to automate repetitive tasks and
command sequences. With the VSTA Manager
toolbar, you can easily record, edit, and run
VSTA macros. In addition, integration with the
VSTA development environment offers
extended functionality to help users create
advanced macros. Users without a Microsoft
Visual Studio licence can run VSTA macros.

Enhanced! LISP support: If you're migrating
from AutoCAD, there's no need to rewrite
time-saving macros that automate common
tasks and extend the feature set. CorelCAD
2015 fully supports LISP routines created for
AutoCAD. Other enhancements include
support for Visual Lisp and ARX. CorelCAD
2015 also provides Icon menu support when
working with LISP routines. This means that
you can build custom dialog boxes that display
preview thumbnails (SLD) of CAD components,
which is especially useful for building custom
libraries. In addition, CorelCAD 2015 adheres
to a common structure for LISP programming,
making it easy to reuse any existing
automations without need to recompile.

Running a LISP macro

1 In the 3D Modeling or Drawing and
Annotation workspace, click the Manage
tab.

CorelCAD 15
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Give it a try

2 In the Applications group, click the
Load Application @] button.

3 In the Select File dialog box, navigate to the
sample file DrawCircle.lsp ((available for
download here), and click Open.

Running this LISP routine, originally created
for AutoCAD, can save time when drawing
a series of circles of a pre-defined size.

4 In the Applications group, click the
Load Application button.

5 In the Select File dialog box, navigate to the
sample file DrawingProps.Isp and click
Open.

Running this LISP routine retrieves and
allows you to edit document summary
properties.

Having the ability to use LISP routines from
other CAD programs allows you to extend
functionality and enhance tools without
having to spend time coding.
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Integrating CorelCAD™ 2015 into other graphics workflows

CorelCAD 2015 bridges the gap between CAD and other graphics workflows by offering import
from and export to CDR and DES formats.

Marketing
collateral

Sketching &
vector tracing
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CAD applications usually provide very little file
support for exporting drawings, creating a
disconnect when you're trying to repurpose
CAD for technical illustration or marketing
design.

Unique to CorelCAD, this level of file support
creates a complete, compatible graphics
workflow from Corel, covering everything from
concept design (CorelDRAW or Corel Painter), to
CAD (CorelCAD), technical illustration (Corel
DESIGNER) and marketing deliverables
(CorelDRAW and Corel PHOTO-PAINT).

CorelDRAW CorelCAD

This simplifies the process of getting CAD
models into downstream graphics workflows.
CAD drawings are unreadable to most people.
Exporting 3D CAD to a vector-based format,
such as CorelDRAW or Corel DESIGNER, allows
you to repurpose that content.

The vector files can be used in Corel DESIGNER
to create technical illustrations destined for a
wide variety of documentation, such as
assembly instructions, parts catalogs, and
training materials.

You can then leverage those technical
illustrations in a creative way using CorelDRAW
and Corel PHOTO-PAINT to create a range of
marketing materials, such as flyers, web pages,
presentations, and more

PHOTO-PAINT

* Please note, import and export of CoreIDRAW (.CDR) and
Corel DESIGNER (.DES) file formats is only available in
CorelCAD 2015 for Windows.

[ 20 ] Reviewer’s Guide

CorelCADzo1s

powered by ARES®



)

Comparing CorelCAD™ 2015 for Windows and Mac OS to

Light CAD applications

This table compares the features included in CorelCAD 2015 to features offered in other Light

CAD applications.

CorelCAD 2015

Light CAD applications

File support

AutoCAD R2013 .DWG native file format v v
Legacy CAD file (AutoCAD R12 .DWG) support v -

DXF (Drawing Exchange File) support v v
Template Drawings (DWT) support v v
Drawing web format (DWF) support v -

Recovery of corrupted drawings v v
Raster image support (BMP, GIF, JPG, PNG, TIFF) v

OLE support v v
Import CorelDRAW® (CDR) and Corel DESIGNER® (DES) v -

Number of supported file formats - Import 12*/10 ~5

Ribbon user interface (Ul)

User interface

v x

V&

Classic menu and toolbars

Edit multiple drawings (MDI)

Dockable Properties palette

AR RN

Tool matrix

Design Resources docker

References Manager palette

Right-click context menus

Command prompt area

Industry-standard command sequences

Options Settings Manager

ANERNEN

Search in Options dialog box

AN ERN NN N N YN NN N

[* — Windows version only; (v') — limited availability/support]
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CorelCAD 2015

Light CAD applications

Viewing and Selection tools

Real-time Pan and Zoom v v
3D Mouse navigation v v
Object Snap (ESnap) v v
Object Tracking (ETrack) / dynamic guides v v
QuickGroup tool and Group Selection mode setting v v
Layers Toolbar v v
Layer states (Save and Restore) 4 v
Layer Tools v v
Layer Transparency v v
Layer Preview tool v -
Rectangle creation with support for area and dimension v v
Line weights (display and print) v v
Exploding Splines and Ellipses (to polylines) v -
Exploding blocks instances while maintaining attributes (ExplodeBlockX) New! -
Multiline v v
Drawing constraints (Parametric drawing tools) New!* v
QuickModify command (move, rotate, copy in one tool) New! -
PowerTrim New! -
Simplify drawings by removing overlapping objects (DiscardDuplicates) New! v
Hatch editing v v
Gradient hatch v
True Colors support v v
Multi-language character set v v
TrueType Fonts support v v
Spell checking v v
In-Place multiline text editing v -
In-Place editing of stacked text New! v
In-Place editing of block definitions and external references v v
Dynamic blocks support (inserting and manipulating) New! v
CAD drawing standards verification v -
Associative dimensions v v
Arc length dimensions v v
Jogged radius dimensions v v
Smart Dimensioning tool v (‘/)
Dimension palette (dynamic onscreen properties bar) New! -
Redline and markup v v

[* — Windows version only; (v') — limited availability/support]
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CorelCAD 2015

Light CAD applications

Revision clouds
3D viewing and design

3D model viewing

PDF Underlay v v

DGN (Microstation CAD file format) Underlay 4 v

VoiceNotes v -
v v

Projected (Isometric) views

Shaded / Rendered display modes

Lights

Materials Optional (w/ Render plug-in)

*

—~

3D surface commands

3D solid modeling
Layout tools

Tables

ARSI ENENENEN

Images / References / Underlay rectangular and polygonal clipping

Masking Entities (Wipe out)

Non-rectangular viewports
Printing, plotting, layout sheets
Multiple Layout Sheet Tabs (Multiple Paper Spaces)

N RYRYE

N RYRNE

Lock Layout Viewports

CTB Color table support

STB Style table support

Print Configuration Manager

Batch Print
Publishing/Output
Export to CorelDRAW (.CDR) and Corel DESIGNER (.DES)

N ANRNENENEN

N

N AVANENENEN

Export to PDF

PDF Creation using Print Table Styles

ANERN

Export to SVG (Scalable Vector Graphics)

STL Export for 3D printing

N RYRYE

JPEG / PNG output using Print Table Styles

<

Number of support file formats - Export

17*15

Pack and Go command

GIS file format support (ESRI Shape *.shp files) v -
3D Solid geometry exchange file format (*.sat) support v -
v v

[* — Windows version only; (v') — limited availability/support]
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Customization

Programming

Visual Menu and Toolbar Customization v v
Ribbon Ul customization New!* v
User profiles management v -

CUI Menu files support v v
CUIX (AutoCAD Ribbon Ul workspaces) import Enhanced!* v*
Upgrade user settings from previous version New! v

Plug-in Store (corelcadmarket.com)

LISP (including support for LISP commands from other CAD applications) v -

COM API o B

Microsoft Visual Studio Tools for Applications (VSTA) support v -
v

Educational licenses

OS support

Single license v v
Network licenses v -
Maintenance (upgrade protection) v v

v v

MSI-based network deployment

Windows 8/8.1 v v
Windows 7 v v
Native 64-bit application v v
32-bit 0S support v v
Mac 0S X Yosemite (10.10) New! -
Mac 05 X (10.7-10.9) v v
vx vox

Minimum system requirements

Windows

*  Microsoft Windows 8, Microsoft Windows 7
(32-bit or 64-bit versions)

e Intel Pentium 4 (2 GHz or faster)
e 2 GB RAM (4 GB or more recommended)
* 500 MB free hard disk space

* High-color (16-bit) graphics card (3D graphics
accelerator card recommended)

e 1024 x 768 screen resolution (1200 x 800
recommended)

*  Mouse or tablet
e (CD-ROM drive for installation from CD

* Internet connection for installation from
download and access to the plug-in store

Mac 0OS

*  Mac OS Xv10.7 (Lion), v10.8 (Mountain Lion),
v10.9 (Mavericks), or v10.10 (Yosemite)

* Intel processor
e 1 GB RAM (2GB recommended)
* 500 MB hard-disk space

* 1024 x 768 display (1280 x 800
recommended) with 16-bit video card

*  Mouse or tablet
¢ (CD-ROM drive for installation from CD

* Internet connection for product activation
and access to the plug-in store
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About Corel

Corel is one of the world’s top software companies providing some of the industry’s best-known
graphics, productivity and digital media products. Boasting the most comprehensive portfolio of
innovative software, we've built a reputation for delivering solutions that are easy to learn and use,
helping people achieve new levels of creativity and productivity. The industry has responded with
hundreds of awards for innovation, design, and value.

Used by millions of people around the world, our product lines include CoreDRAW® Graphics Suite,
CorelDRAW® Technical Suite, CorelCAD ", Corel® Painter®, Corel® PaintShop® Pro,

Corel® VideoStudio®, and Corel® WordPerfect® Office. For more information on Corel, please visit
www.corel.com.
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